
 
 

 

 

 

 

 

 

 

 

 

CY3641, CY3642, and CY3643  
Programming Kits Guide 

 

Doc. No. 002-19586 Rev. *B 

 

 

 

 

 

 

 

 

 

 

 

 

 

Cypress Semiconductor 

198 Champion Court 

San Jose, CA95134-1709 

www.cypress.com 

http://www.cypress.com/


CY3641, CY3642, and CY3643 Programming Kits Guide, Doc. No. 002-19586 Rev. *B 2 

Copyrights 

© Cypress Semiconductor Corporation, 2017. This document is the property of Cypress Semiconductor Corporation and its 
subsidiaries, including Spansion LLC (“Cypress”).  This document, including any software or firmware included or 
referenced in this document (“Software”), is owned by Cypress under the intellectual property laws and treaties of the 
United States and other countries worldwide.  Cypress reserves all rights under such laws and treaties and does not, except 
as specifically stated in this paragraph, grant any license under its patents, copyrights, trademarks, or other intellectual 
property rights.  If the Software is not accompanied by a license agreement and you do not otherwise have a written 
agreement with Cypress governing the use of the Software, then Cypress hereby grants you a personal, non-exclusive, 
nontransferable license (without the right to sublicense) (1) under its copyright rights in the Software (a) for Software 
provided in source code form, to modify and reproduce the Software solely for use with Cypress hardware products, only 
internally within your organization, and (b) to distribute the Software in binary code form externally to end users (either 
directly or indirectly through resellers and distributors), solely for use on Cypress hardware product units, and (2) under 
those claims of Cypress’s patents that are infringed by the Software (as provided by Cypress, unmodified) to make, use, 
distribute, and import the Software solely for use with Cypress hardware products.  Any other use, reproduction, 
modification, translation, or compilation of the Software is prohibited. 

TO THE EXTENT PERMITTED BY APPLICABLE LAW, CYPRESS MAKES NO WARRANTY OF ANY KIND, EXPRESS 
OR IMPLIED, WITH REGARD TO THIS DOCUMENT OR ANY SOFTWARE OR ACCOMPANYING HARDWARE, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE. To the extent permitted by applicable law, Cypress reserves the right to make changes to this 
document without further notice. Cypress does not assume any liability arising out of the application or use of any product 
or circuit described in this document.  Any information provided in this document, including any sample design information 
or programming code, is provided only for reference purposes.  It is the responsibility of the user of this document to 
properly design, program, and test the functionality and safety of any application made of this information and any resulting 
product.  Cypress products are not designed, intended, or authorized for use as critical components in systems designed or 
intended for the operation of weapons, weapons systems, nuclear installations, life-support devices or systems, other 
medical devices or systems (including resuscitation equipment and surgical implants), pollution control or hazardous 
substances management, or other uses where the failure of the device or system could cause personal injury, death, or 
property damage (“Unintended Uses”).  A critical component is any component of a device or system whose failure to 
perform can be reasonably expected to cause the failure of the device or system, or to affect its safety or effectiveness.  
Cypress is not liable, in whole or in part, and you shall and hereby do release Cypress from any claim, damage, or other 
liability arising from or related to all Unintended Uses of Cypress products.  You shall indemnify and hold Cypress harmless 
from and against all claims, costs, damages, and other liabilities, including claims for personal injury or death, arising from 
or related to any Unintended Uses of Cypress products. 

Cypress, the Cypress logo, Spansion, the Spansion logo, and combinations thereof, WICED, PSoC, CapSense, EZ-USB,  
F-RAM, and Traveo are trademarks or registered trademarks of Cypress in the United States and other countries.  For a 
more complete list of Cypress trademarks, visit cypress.com.  Other names and brands may be claimed as property of their 
respective owners. 

 

 

 



 

CY3641, CY3642, and CY3643 Programming Kits Guide, Doc. No. 002-19586 Rev. *B 3 

Contents 

  

Safety Information .................................................................................................................................................................. 4 

1. Introduction .................................................................................................................................................................... 5 
1.1 CY364x Programming Kits Contents ..................................................................................................................... 5 
1.2 Getting Started ...................................................................................................................................................... 7 
1.3 Additional Learning Resources .............................................................................................................................. 7 
1.4 Technical Support .................................................................................................................................................. 7 
1.5 Document Conventions ......................................................................................................................................... 8 
1.6 Acronyms............................................................................................................................................................... 8 

2. Software Installation ..................................................................................................................................................... 9 
2.1 Before You Begin .................................................................................................................................................. 9 
2.2 Install Software ...................................................................................................................................................... 9 
2.3 Install Hardware ................................................................................................................................................... 12 
2.4 Uninstall Software ................................................................................................................................................ 12 

3. Kit Operation ................................................................................................................................................................ 13 
3.1 Theory of Operation ............................................................................................................................................. 13 
3.2 Functional Description ......................................................................................................................................... 15 
3.3 CY364x Kit USB Connection ............................................................................................................................... 16 
3.4 eFuse Programming of the CY294xx Clock Device ............................................................................................. 17 

4. Hardware ...................................................................................................................................................................... 20 
4.1 Board Overview ................................................................................................................................................... 20 

5. Additional Features of CY3641 ................................................................................................................................... 23 
5.1 Power up the Clock Device.................................................................................................................................. 23 
5.2 Measuring Parameters of the Programmed Clock Device ................................................................................... 24 

A. Using Bridge Control Panel with an I2C Configuration File ..................................................................................... 25 

B. Possible Hardware Modification ................................................................................................................................ 27 
B.1 Configure the LDO for Multiple Supplies of 1.8V, 2.5V or 3.3V ........................................................................... 27 
B.2 Mounting SMA Connectors and Components for Termination Setting ................................................................ 28 

C. Generating a Device Configuration ............................................................................................................................ 30 

D. Schematics, Bill of Materials, and Fab Drawing ....................................................................................................... 33 
D.1 CY3641 Schematics, Bill of Materials, and Fab Drawing ..................................................................................... 33 
D.2 CY3642 Schematics, Bill of Materials, and Fab Drawing ..................................................................................... 38 
D.3 CY3643 Schematics, Bill of Materials, and Fab Drawing ..................................................................................... 44 

Revision History ................................................................................................................................................................... 49 



 

CY3641, CY3642, and CY3643 Programming Kits Guide, Doc. No. 002-19586 Rev. *B 4 

Safety Information 

 

The CY3641, CY3642, and CY3643 Programming Kits are intended for use as programming platform for hardware or 
software in a laboratory environment. The board is an open system design, which does not include a shielded enclosure, so 
the board may cause interference to other electrical or electronic devices in close proximity. In a domestic environment, this 
product may cause radio interference. In such cases, the user may be required to take adequate preventive measures. 
Also, this board should not be used near any medical equipment or RF devices. 

Attaching additional wiring to this product or modifying the product operation from the factory default may affect its 
performance and cause interference with other apparatus in the immediate vicinity. If such interference is detected, suitable 
mitigating measures should be taken. 

 

CY3641, CY3642, and CY3643 Programming Kits contain electrostatic discharge (ESD)-sensitive 
devices. Electrostatic charges readily accumulate on the human body and any equipment, and can 
discharge without detection. Permanent damage may occur on devices subjected to high-energy 
discharges. Proper ESD precautions are recommended to avoid performance degradation or loss of 
functionality. Store unused CY3641, CY3642, and CY3643 Programming Kit boards in the protective 
shipping package. 

 
General Safety Instructions 
ESD Protection  
ESD can damage boards and associated components. Cypress recommends that the user perform procedures only at an 
ESD workstation. If an ESD workstation is not available, use appropriate ESD protection by wearing an antistatic wrist strap 
attached to the chassis ground (any unpainted metal surface) on the board when handling parts. 

Handling Boards 
The CY3641, CY3642, and CY3643 Programming Kits are sensitive to ESD. Hold the board only by its edges. After 
removing the board from its box, place it on a grounded, static-free surface. Use a conductive foam pad if available. Do not 
slide the board over any surface. 

Certification Disclaimer  

This kit is intended for programming purposes only and is not considered by Cypress Semiconductor to be a finished end-
product fit for general consumer use. It generates and can radiate radio frequency energy and has not been specifically 
tested for CE certification compliance. Operation of this equipment in other environments may cause interference with radio 
communications, in which case users at their own expense will be required to take whatever measures may be required to 
correct this interference. 
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1.   Introduction 

 

Thank you for your interest in CY3641, CY3642, and CY3643 Programming Kits. This collection of kits will be referred to as 
“kits” or “CY364x” henceforth, whereas when something specific to a particular kit is of interest, the specific part number will 
be used.  

CY364x kits are designed to enable you to program the CY294xx programmable clock devices, the latest additions to the 
Cypress timing product portfolio. CY3641 and CY3642 kits are used to program the LCC 8-pin 7mm x 5mm (MPN 
CY2941x) and LCC 8-pin 5mm x 3.2mm (MPN CY2942x) devices respectively. The CY3643 kit is used to program the QFN 
16-pin 3mm x 3mm (MPN CY29430) device. The CY294xx clock devices are high-performance programmable oscillators 
with one fractional PLL that generates any frequency up to 2.1 GHz with jitter as low as 110 fs. For more details, refer to the 
respective device datasheet – CY2941x/CY2942x, CY29430.   

CY364x Programming Kits allow you to program the CY294xx series of clock device. These are available through the 
Cypress Online Store or through our distributors. 

Table 1-1. Kit and IC Compatibility 

Programming Kit Programmable IC Package (mm x mm) 
CY3641 CY29411FLXI, CY29412FLXI  LCC 8-pin 7.0x5.0 

CY3642 CY29421FLXI, CY29422FLXI LCC 8-pin 5.0x3.2 

CY3643 CY29430QFLXI QFN 16-pin 3.0x3.0 
 

1.1   CY364x Programming Kits Contents 
CY364x Programming Kits include the following: 

• CY364x Programming Board and an appropriate size clock IC placed inside the socket. 
• USB Standard-A to Mini-B cable 
• Quick Start Guide 
 

Inspect the contents of the kit. If you find any part missing, contact your nearest Cypress sales office for assistance: 
www.cypress.com/support. 

http://www.cypress.com/file/280111/download
http://www.cypress.com/file/280106/download
http://www.cypress.com/cypress-store
http://www.cypress.com/support
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Figure 1-1. CY3641 Kit Contents 

 
 

Figure 1-2. CY3642 Kit Contents 
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Figure 1-3. CY3643 Kit Contents 

 

1.2   Getting Started 
Refer to the CY364x Quick Start Guide inside the kit box or in the installation directory to get started quickly. The default 
location for kit documents is <Install_Directory>\CY364x Programming Kit\<version>\Documentation.   

This Kit Guide is organized in following chapters: 

 The Software Installation chapter describes the installation of the kit software.  

 The Kit Operation chapter describes the major features of the Programming Kits.  

 The Hardware chapter describes the hardware content of the CY364x Programming Kits and the hardware operation.  

 The Additional Features of CY3641 chapter describes how to use CY3641 to read-out clock frequency once a device 
has undergone eFuse programming.   

 Appendix A list steps to execute eFuse programming for a configuration file in I2C format using Cypress’ Bridge Control 
Panel. 

 Appendix B may be used to extend the functionality of the programming kits with minor modifications in hardware by 
mounting/unmounting a few components. 

 Appendix C may be used if you want a quick review on How to generate a JEDEC Configuration file.  

 Appendix D lists Schematics, Fab Drawing, and the bill of materials (BOM) for all the three kits. 

1.3   Additional Learning Resources 
Visit the Cypress CY364x Programming Kits web page and www.cypress.com/HPO for additional learning resources 
including datasheets and application notes. 

1.4   Technical Support 
For assistance, go to www.cypress.com/support, or contact our customer support at +1(800) 541-4736 Ext. 2 (in the USA), 
or +1 (408) 943-2600 Ext. 2 (International). 

 

 

http://www.cypress.com/documentation/development-kitsboards/cy364x-programming-kits
http://www.cypress.com/HPO
http://www.cypress.com/support
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1.5   Document Conventions 
Table 1-2. Document Conventions for Guides 

Convention Usage 

Courier New Displays file locations, user entered text, and source code:  
C:\ ...cd\icc\ 

Italics Displays file names and reference documentation. 

File > Open Represents menu paths: 
File > Open > New Project 

Bold Displays commands, menu paths and icon names in procedures: 
Click the File icon and then click Open. 

Times New Roman Displays an equation: 
2 + 2 = 4 

Text in gray boxes Describes Cautions or unique functionality of the product. 

1.6   Acronyms 
Table 1-3. List of Acronyms used in this Document 

Acronym Definition 

BOM Bill of Materials 

BCP Bridge Control Panel 

CML Current Mode Logic 

DNP, DNM Do Not Populate, Do Not Mount 

FS Frequency Select 

HCSL High-Speed Current Steering Logic 

I2C Inter-Integrated Circuit 

JEDEC Joint Electron Device Engineering Council 

LDO Low-Dropout 

LVCMOS Low Voltage Complementary Metal Oxide Semiconductor 

LVPECL Low Voltage Positive Emitter Coupled Logic 

LVPECL2 Low Voltage Positive Emitter Coupled Logic with zero Common-mode current 

LVDS Low Voltage Differential Signaling 

OE Output Enable 

OT3 Third Overtone Crystal 

SMA Subminiature Version A 

VCXO Voltage-Controlled Crystal Oscillator 

TCXO Temperature Compensated Crystal Oscillator 

OTP One-Time Programmable 
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2.   Software Installation 

 

2.1   Before You Begin 
All Cypress software installations require administrator privileges. Ensure that you have the required privileges on the 
system for successful installation. Before you install the kit software, close any other Cypress software that is currently 
running. 

2.2   Install Software 
1. Download the CY364x Programming Kit software from Cypress CY364x Programming Kits web page. The software is 

available in the following formats: 

• CY364x Programming Kit Complete Setup: This installation package contains the files related to CY364x 
Programming Kits. However, it does not include the Windows Installer or Microsoft .NET Framework packages. If 
these packages are not available on your computer, the installer directs you to download and install them from the 
Internet. 

• CY364x Programming Kit Only: This executable file installs only the CY364x Kit contents, which include example 
configuration files, hardware files, and user documents. This package can be used if all the software prerequisites 
are installed on your PC. 

• CY364x Programming Kit ISO: This file is a complete package, stored in a CD/DVD-ROM image format that you 
can use to create a CD/DVD or extract using an ISO extraction program such as WinZip or WinRAR. The file can 
also be mounted similar to a virtual CD/DVD using virtual drive programs such as Virtual CloneDrive and 
MagicISO. This file includes all the required software, utilities, drivers, hardware files, and user documents. 

2. If you have downloaded the ISO file, mount it on a virtual drive. If you do not have a virtual drive to mount, extract the 
ISO contents using the appropriate ISO extractor (such as MagicISO or PowerISO). Double-click cyautorun.exe in the 
root directory of the extracted content or the mounted ISO if the “Autorun from CD/DVD” option is not enabled on the 
PC. The installation window will appear automatically.  

Note: If you are using the “Kit Complete Setup” or “Kit Only” file, then go to step 4 for installation. 

3. Click Install CY364x Kit to start the installation as shown in Figure 2-1. 

http://www.cypress.com/documentation/development-kitsboards/cy364x-programming-kits
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Figure 2-1. Installer Screen 

 
 

4. Click Change… if you want to install the CY364x Kit in a location other than the default, and then click Next as shown 
in Figure 2-2. 

Note: When you click Next, the CY364x Kit installer automatically installs the required software, if it is not present on 
your computer. The pre-requisite is PSoC Programmer 3.27.0 or later. 

Figure 2-2. InstallShield Wizard 

 
5. Select the Installation Type (see Figure 2-3). The drop-down menu contains three options: Typical (installs all the 

required features), Custom (lets you choose the features to be installed), and Complete (installs all the contents). 
Click Next after you select the Installation Type. 
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 Note: It is recommended that you choose the Typical Installation Type. 

Figure 2-3. Product Installation Overview 

 
 

6. Read and accept the End-User License Agreement, and then click Next. 

When the installation begins, a list of packages appears on the Installation page. A green check mark appears next to 
each package after successful installation. 

7. Enter your contact information or select the Continue Without Contact Information check box. 

8. Click Finish to complete the CY364x Programming Kit installation. 

After the installation is complete, the kit contents are available at:  

<Install_Directory>\CY364x Programming Kit\<version>.   

Default location: 

Windows 7 (64-bit): C:\Program Files (x86)\Cypress\CY364x Programming Kit  

Windows 7 (32-bit): C:\Program Files\Cypress\CY364x Programming Kit  
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2.3   Install Hardware 
No additional hardware installation is required for this kit. 

2.4   Uninstall Software 
You can uninstall the software using one of the following methods: 

• Go to Start > All Programs > Cypress > Cypress Update Manager > Cypress Update Manager, and select the 
specific software package. Click the Uninstall button. 

• Go to Start > Control Panel > Programs and Features, and select the specific software package. Click the 
Uninstall/Change button. 
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3.   Kit Operation 

 

CY364x kits are used to program Cypress’ CY294xx parts, high-performance programmable oscillators. Connect the 
CY364x kit through USB to a PC running Cypress’ Clock Programmer 1.7 application, which comes bundled with PSoC® 
Programmer™ 3.27 or later.  

3.1   Theory of Operation 
CY364x Programming kits are used to program CY294xx programmable clock devices, the latest additions to the Cypress 
timing product portfolio. Programming is done at a fixed voltage of 2.5 V supplied by the Low Dropout (LDO) regulator. The 
on-board PSoC 5LP device (U7) performs the USB-to-I2C conversion. There is one power LED (LED2) driven from the on-
board LDO supply and one status LED (LED1) controlled by PSoC 5LP. CY3641 comes with SMA connectors which may 
be used to evaluate the crystal frequency at 2.5 V.  Figure 3-1, Figure 3-2, and Figure 3-3 illustrate the block diagram of the 
CY3641, CY3642 and CY3643 Programming Kits respectively. 

Figure 3-1. CY3641 Programming Kit Block Diagram 
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Figure 3-2. CY3642 Programming Kit Block Diagram 

 
 

Figure 3-3. CY3643 Programming Kit Block Diagram 
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3.2   Functional Description 
Programming a clock device permanently for a configuration, which will make the clock device boot into that configuration at 
power up, is called eFuse programming. The kit is designed to power up the device placed in the socket only during eFuse-
programming; the power supply is shut down after programming is complete. This allows for the safe removal of the 
programmed device from the socket.    

Figure 3-4 illustrates the top view and bottom view of the CY3641 kit, Figure 3-5 that of CY3642, and Figure 3-6 that of 
CY3643.  

Figure 3-4. CY3641 Programming Kit (Top View, Bottom View) 

  
CY3641 Kit Top View CY3641 Kit Bottom View 

 

Figure 3-5. CY3642 Programming Kit (Top View, Bottom View) 

  
CY3642 Kit Top View CY3642 Kit Bottom View 
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Figure 3-6. CY3643 Programming Kit (Top View, Bottom View) 

  
CY3643 Kit Top View CY3643 Kit Bottom View 

 

3.3   CY364x Kit USB Connection 
CY364x kits connect to a PC through a USB-A to Mini-B cable provided in the kit box. The kit enumerates as a USB 
Composite Device as part of driver software installation on Windows. 

Figure 3-7. Kit Connected Through USB 
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Figure 3-8. USB Driver Installation in Progress 

 
 

Figure 3-9. USB Driver Installation Complete 

 
After driver enumeration is complete, the Status LED (LED1) will glow green and device is now ready to use. 

3.4   eFuse Programming of the CY294xx Clock Device  
CY294xx devices have an internal one-time programmable (OTP) nonvolatile memory called eFuse. The device also 
contains volatile memory; the contents of nonvolatile memory get copied to the volatile memory at the release of reset at 
power up. The output frequency depends on the configuration in the volatile memory. The configuration file used to program 
the clock device should be in JEDEC format. Example configuration files can be found in <Install_Directory>\CY364x 
Programming Kit\<version>\Firmware; refer to Appendix C for a brief description on how to generate a configuration file.  

Once a device is eFuse programmed (once the eFuses are blown) it can’t be undone. It is therefore strongly recommended 
that the JEDEC file be tested for intended clock performance before writing the configuration parameters in the device non-
volatile memory. To permanently program a clock device, Cypress Clock Programmer 1.7.0 or later is used. Clock 
Programmer comes bundled with PSoC Programmer, which can be downloaded from Cypress PSoC Programming 
Solutions page. 

I. Connect the programming kit to a PC using the USB Standard-A to Mini-B cable and make the following initial 
jumper settings: 

1. J1: short 1 and 2. 
2. Verify that Status LED (Green, LED1) glows. 

II. Launch the Clock Programmer application from Start > All Programs > Cypress > Clock Programmer.  

III. Place a blank clock device inside the socket (CY364x kits come with a blank device placed inside the socket). See 
Figure 3-10 and follow the instructions below: 

1. Select the CY294xx clock device (device placed in the socket). 

http://www.cypress.com/products/psoc-programming-solutions
http://www.cypress.com/products/psoc-programming-solutions
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2. Select target I2C address: 0x55 
3. Click Connect.  

Figure 3-10. Connect to Clock Device Using Clock Programmer 

  
 

IV. Open a configuration file (for example, <Install_Directory>\CY364x Programming 
Kit\<version>\Firmware\CY3643\CY3643 Kit LVPECL 2.5V 156.25MHz.jed) and execute eFuse-programming. See 
Figure 3-11 and follow the instructions. 

1. Open the JEDEC file using Programming > File Load. 

2. Verify that the JEDEC file is active. 

3. Click Program. You will notice LED2 glow Amber while eFuse programming is underway. 

4. Verify “Programming started…”  

5. Verify that the “Programming finished…” message appears. 
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Figure 3-11. Open JEDEC and Program the Device 

  
 

CAUTION 

The JEDEC file must be correct and verified for intended clock performance before proceeding with 
eFuse programming. Once the eFuses are blown, the content of the nonvolatile memory cannot be 
altered.  

The supply to the clock device must be set to 2.5 V for eFuse programming. Setting the clock supply 
to any other voltage during eFuse programming will cause potential damage to the device. 



 

CY3641, CY3642, and CY3643 Programming Kits Guide, Doc. No. 002-19586 Rev. *B 20 

4.   Hardware 

 

4.1   Board Overview 
CY3641, CY3642, and CY3643 Programming Kits are used to program CY2941x, CY2942x, and CY29430 clock devices.   

CY364x kits have the following features: 

• Powered from a USB port 

• Jumper to short or isolate an external connection for termination settings (applicable only to CY3641) 

Figure 4-1 illustrates the CY3641 board with a markup of the on-board components.  

Figure 4-1. CY3641 Kit On-board Components 
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Figure 4-2 illustrates the CY3642 board with a markup of the on-board components. 

Figure 4-2. CY3642 Kit On-board Components 

 
Figure 4-3 illustrates the CY3643 board with a markup of the on-board components. 

Figure 4-3. CY3643 Kit On-board Components 
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Table 4-1. CY364x Kits Onboard Components Description 

Label Name CY3641 CY3642 CY3643 Description 
Main Power Supply 
Jumper (J1) 

● ● ● 
Short pin 1 and 2 of jumper J1 to power up the clock IC.  

USB Mini-B 
Connector (J3) 

● ● ● Connect the kit to a PC using the USB Standard-A to Mini-B cable. 

SMA Connectors 
(J6 and J7) 

● ᵡ ᵡ Connect SMA cables to the SMA connectors (J6 and J7) on one end and to an 
oscilloscope on the other end. 

Termination 
Jumper (J5) 

● ᵡ ᵡ The board has an on-board jumper (J5) to connect and disconnect output 
termination. 

Status LED (LED1) ● ● ● This LED (LED1) turns ON after the USB enumeration is completed. This LED 
blinks during programming of the clock IC. 

Power LED (LED2) ● ● ● This LED (LED2) turns ON when the CY294xx device is powered. 

PSoC 5LP 
(CY8C5868LTI-
LP039) 

● ● ● On-board PSoC 5LP device that converts the USB data-stream to I2C format to 
program the CY294xx device. 

 

 

CAUTION 
The kit should strictly be operated from a USB supply by connecting to a PC.  
The PCB should not be powered by any external source. Application of an external power source 
to any of the jumper pins or test points may cause potential damage of the PCB. 

 

4.1.1   Power Settings 
The only power option for the CY364x kit is 5 V from a USB port. The device has the same core and I/O supply voltage.  

4.1.2   LED Indicators 
Table 4-2. LED Indicators 

LED Label Indicator Description 

LED1 STATUS LED 
Status of Kit 
connection to the 
PC 

This LED turns ON when the kit is connected to the USB port on a PC using the cable 
provided.  
If this LED does not turn ON, it indicates that the USB enumeration of the kit did not 
happen with the host PC. This LED blinks continuously when the device is being 
programmed through the PSoC 5LP device. 

LED2 POWER LED Clock Device 
Power  

This LED glows when the supply to the socket is powered on. Ensure that a jumper 
shunt is populated at J1, shorting position 1-2.  

 

Note: The hardware files can be found at <Install_Directory>\CY364x Programming Kit\<version>\Hardware.
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5.   Additional Features of CY3641 

  

CY3641 comes with SMA connectors and termination setting that can be controlled using termination jumper J5. Once the 
device is eFuse programmed, you can measure its output parameters using this kit. 

5.1   Power up the Clock Device 
The primary functionality of the programming kits inhibits a continuous supply to the clock device. However, measurement 
of the clock device output parameters demands a continuous power supply. The onboard LDO that supplies power to the 
clock device can be controlled using the onboard controller (PSoC 5LP, U7) and Cypress’ Bridge Control Panel(BCP) 
application which comes bundled with PSoC Programmer (version 3.27 or later). The executable can be downloaded from 
Cypress Programming Solutions web page. Follow the steps listed below to power up the clock device: 

I. Connect the CY3641 kit to a PC with a programmed device placed inside the socket.  

II. Launch the Bridge Control Panel application from Start > All Programs > Cypress > Bridge Control Panel.  

III. To turn ON the power supply to the clock device: 
 
1. Select “KitProg/xxxxxxxxxxx” under head “Connected I2C/SPI/RX8 Ports”.  

2. Verify that the “Connected” indicator turns ‘Green’ indicating that the kit is connected successfully. 

3. Toggle the power button. This turns ON/OFF the power supply to the clock device.  

 
IV. Verify that LED2 (Amber Power LED) turns ON. This ensures that the clock IC is powered.   

http://www.cypress.com/products/psoc-programming-solutions
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5.2   Measuring Parameters of the Programmed Clock Device 
See the CY3676 Evaluation Kit user guide for details on measuring the parameters and evaluating the clock device. Do the 
following to measure one output standard and one voltage.  

Configuration File (JEDEC) to use: eFuse the JEDEC file in the installation directory under <Install_Directory>\CY364x 
Programming Kit\<version>\Firmware\CY3641\CY3641 Kit LVPECL 2.5V 156.25MHz.jed 

Configuration Parameters: Set the following parameters: 

• Device: CY29412FLXI 

• Output standard: LVPECL 

• Voltage: 2.5 V 

• Frequency output 156.25 MHz. 

Termination Setting: Short Jumper J5. 

Measurement Setup: Connect the SMA connectors J6 and J7 to an oscilloscope (Figure 5-1 is taken on an 8-GHz 
oscilloscope). 

Observation: With the programmed device inside the socket, LED2 glowing and the kit properly connected to an 
oscilloscope through the SMA Cable, the output signal and its parameters can be measured as shown in Figure 5-1.  

Figure 5-1. CY29412FLXI Differential Output of 156.25 MHz and Output Standard as LVPECL 

 
 

http://www.cypress.com/documentation/development-kitsboards/cy3676-evaluation-kit
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A. Using Bridge Control Panel with an I2C 
Configuration File 

 

If the configuration file is in the I2C format (iic), it requires Cypress’ Bridge Control Panel software version 1.17 or later to 
program the clock device.  You can download it from Cypress PSoC Programming Solutions web page.  To get your 
JEDEC file converted into I2C format contact Cypress via e-mail at clocks@cypress.com. For this section, a configuration 
file with all the 4 FS profiles enabled is used.   

Open the Bridge Control Panel tool from the Start menu > All Programs > Cypress > Bridge Control Panel > Bridge Control 
Panel. Follow the instructions in order as listed below: 

1. Select KitProg/xxxxxxxxxxx under Connected I2C/SPI/RX8 Ports. The connected indicator turns green indicating 
that the kit is connected successfully.  

2. Use Power Toggle. This will power up the device placed inside the socket. The Power Indicator pannel turns green; 
you will also see that the Power LED (LED2) on the Kit turns ON.  

3. Go to File > Open File > <filename>.iic (example iic files can be found at <Install_Directory>\CY364x Programming 
Kit\<version>\Firmware\CY3643\CY3643 Kit LVPECL 2.5V 156.25MHz eFuse.iic). The sequence of commands will 
appear in the editor, as shown in Figure A-1. 

4. Check the Send all strings box. 

5. Click the Send button. 

Figure A-1. eFuse Programming with I2C File Using Bridge Control Panel 

  
 

http://www.cypress.com/products/psoc-programming-solutions
mailto:clocks@cypress.com
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You can see all the I2C transactions as they occur in the log window. The last few commands in the I2C configuration files 
are read commands. As shown in Figure A-2, the read data must match the FS0-FS3 parameters as well as the common 
parameters. If these configuration parameters match, it guarantees that eFuse programming was successful.  

Figure A-2. Verify eFuse Programming by Comparing Data Read Back from Memory 
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B. Possible Hardware Modification 

 

 

The Kits CY364x are intended with a primary purpose of enabling users to program Cypress CY294xx clock ICs; however 
there are footprints made available that may be used to extend the kit functionality. Some of the options are listed in this 
section.  

B.1 Configure the LDO for Multiple Supplies of 1.8V, 2.5V or 3.3V 
This modification must only be used when evaluating an eFuse-programmed part. The kits come with a fixed voltage supply 
of 2.5 V. If the clock IC is eFuse-programmed for operation at 2.5 V, you can simply follow the steps mentioned in Section 
5.1   to power up the eFuse-programmed clock IC. However, if the clock IC is eFuse-programmed for operation at a voltage 
other that 2.5 V, i.e., 1.8 V or 3.3 V, you can still use the onboard LDO with its resistor divider network populated as shown 
in Figure B-1.  

Figure B-1. LDO Divider Network for Supply of 1.8 V, 2.5 V, or 3.3 V to Clock IC 

 
The changes required are shown in Table B-1. 

Table B-1. Modification in LDO Divider Network 

Component Default Setting Modification 

R201 10k  10k 

R202 10k 22.6k 

R203 DNP, 8.25k  8.25k 

R204 DNP, 18k 18k 

J13 DNP, Jumper Jumper 
 

The Jumper position settings to switch the voltage supply are shown in Table B-2. 

Table B-2. Jumper (J13) Setting to Switch Clock Supply 

Jumper Setting (J13) VDD_I 
Short 2 & 3  3.3V 

Short 1 & 2 2.5V 

Open 1.8V 
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B.2 Mounting SMA Connectors and Components for Termination Setting 
The CY3641 kit comes with SMA connectors and termination setting in place. CY3642 and CY3643 kits, however only have 
footprints for SMAs and for components required for setting the termination voltage. Figure B-2 shows the schematic for 
CY3642, with components inside the box termination settings as DNP; you need to mount these components with their 
respective values. Similarly, for the CY3643 kit, Figure B-3, the box termination settings has components as DNP, which 
should be mounted before you can use this board to evaluate the eFuse-programmed clock IC.  

Once the SMAs and components for termination setting are mounted, use the steps in Section 5.1   to power up the clock 
IC. For more details on how to evaluate CY2942x devices, refer to Kit guide of CY3676 Evaluation Kit. For details on how to 
evaluate CY29430 devices, refer to Kit Guide for Evaluation Kit CY3677. 

Figure B-2. Mounting SMAs and Termination Settings Components on CY3642 board. 

 

http://www.cypress.com/documentation/development-kitsboards/cy3676-evaluation-kit
http://www.cypress.com/documentation/development-kitsboards/cy3677-evaluation-kit
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Figure B-3. Mounting SMAs and Termination Settings Components on CY3643 board. 
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C. Generating a Device Configuration 

 

ClockWizard 2.1 is used to generate a configuration file. The software is not included with the kit installer. Download it from 
Cypress ClockWizard 2.1 web page. For detailed instructions on how to generate a configuration file see the user guide for 
ClockWizard 2.1. The steps are also briefly discussed here for ready reference.  

1. Launch the ClockWizard 2.1 application: Go to Start > All Programs > Cypress > ClockWizard 2.1.  

2. Create a new Workspace using File > New workspace, give a name to your workspace and a directory location. An 
existing workspace can also be opened using File > Open workspace.  

3. Projects for a configuration need to be added in a workspace. To add a project, use File > New project. A New Project 
pop-up will appear as shown in Figure C-1. Select a relevant device and give a name to the configuration project. 

Figure C-1. Add a New Project 

 
4. Figure C-2 shows a Workspace with a project for the configuration of a CY29412 device.  Click the Generate button 

located at the bottom of the block-diagram section of the ClockWizard 2.1 window to generate the configuration file.  

http://www.cypress.com/documentation/software-and-drivers/clockwizard-21
http://www.cypress.com/file/292461/download
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Figure C-2. Generate a Configuration File 

 
5. The resulting JEDEC file can be seen at the top-right corner as shown in Figure C-3. You can also find the resulting 

JEDEC file in the Workspace folder. For more information on configuration parameters, see the user guide for 
ClockWizard 2.1, which can be accessed from Help > User guide. 

Figure C-3. Configuration Parameters and JEDEC File 
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CAUTION 

Before proceeding through the stages of eFuse programming a clock device, it is assumed that 
a correct configuration file is available.  

A correct configuration provides the intended device performance. Instructions on how to 
evaluate a configuration before eFuse programming to a device can be found in the user guide 
of the CY3676 Evaluation Kit or CY3677 Evaluation Kit.  

 

http://www.cypress.com/documentation/development-kitsboards/cy3676-evaluation-kit
http://www.cypress.com/documentation/development-kitsboards/cy3677-evaluation-kit
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D. Schematics, Bill of Materials, and Fab 
Drawing 

 

D.1 CY3641 Schematics, Bill of Materials, and Fab Drawing 
D.1.1  Schematic  

Figure D-1. Block Diagram 
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Figure D-2. Power Supply Design and LED Indicators 

 
 

Figure D-3. Controller Schematics 
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Figure D-4. Schematics for Socket Connection 

 

D.1.2  CY3641 Fab Drawing 
Figure D-5. Fabrication Drawing 
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D.1.3  CY3641 Bi l l  of  Materia ls 

Item Qty Reference Value Descriptions Manufacturer Manufacturing 
Part Number 

1  1 C6 0.01 UF 
CAP CER 10000PF 50V 10% 
X7R 0603 Murata Electronics  

GRM188R71H103K
A01D 

2 2 C7,C10 4.7Uf 
CAP CER 4.7UF 6.3V X5R 
0603 Murata Electronics 

GRM188R60J475K
E19D 

3 14 
C8,C9,C38,C41,C46,C49,C53,C54,C5
5,C56,C57,C66,C67,C68 0.1uF 

CAP CER 0.1UF 50V Y5V 
0603 Yageo 

CC0603ZRY5V9BB
104 

4 9 
C30,C34,C39,C40,C50,C51,C52,C58,
C59 1UF 

CAP CER 1UF 25V 10% X5R 
0603 Taiyo Yuden TMK107BJ105KA-T 

5 1 F1 

PTC 
RESETABLE 
FUSE 

PTC RESETTABLE .30A 30V 
1812 Bourns Inc. MF-MSMF030-2 

6 1 J1 JUMPER 
CONN HEADR BRKWAY .100 
03POS STR 

TE Connectivity AMP 
Connectors 9-146280-0-03 

7 1 J5 VCM 
CONN HEADR BRKWAY .100 
02POS STR 

TE Connectivity AMP 
Connectors 9-146280-0-02 

8 1 J3 USB MINI B MINI USB RCPT R/A DIP 
TE Connectivity AMP 
Connectors 1734510-1 

9 2 J6,J7 SMA 
CONN SMA JACK 50 OHM 
EDGE MNT 

Cinch Connectivity 
Solutions Johnson 142-0701-801 

10 1 LED1 LED Green 
LED GREEN CLEAR 0805 
SMD 

Visual Communications 
Company - VCC 

CMD17-
21VGC/TR8 

11 1 LED2 LED Amber 
LED AMBER CLEAR 0805 
SMD Bivar Inc. SM0805AC 

12 2 R30,R31 49.9 
RES SMD 49.9 OHM 0.1% 
1/10W 0603 

Panasonic Electronic 
Components ERA-3AEB49R9V 

13 2 R1,R211 560 
RES SMD 560 OHM 5% 
1/10W 0603 

Panasonic Electronic 
Components ERJ-3GEYJ561V 

14 1 R3 100K 
RES SMD 100K OHM 5% 
1/10W 0603 

Panasonic Electronic 
Components ERJ-3GEYJ104V 

15 3 R16,R226,R228 15K 
RES SMD 15K OHM 1% 
1/10W 0603 

Panasonic Electronic 
Components ERJ-3EKF1502V 

16 2 R17,R18 22 
RES SMD 22 OHM 1% 1/10W 
0603 

Panasonic Electronic 
Components ERJ-3EKF22R0V 

17 3 R20,R21,R227 30K 
RES SMD 30K OHM 1% 
1/10W 0603 Yageo RC0603FR-0730KL 

18 2 R201, R202 10k 
RES SMD 10K OHM 1% 
1/10W 0603 Yageo RC0603FR-0710KL 

19 5 R213,R214,R224,R230, R232 0 ohm 
RES SMD 0.0 OHM JUMPER 
1/10W 0603 

Panasonic Electronic 
Components ERJ-3GEY0R00V 

20 1 R216 1K 
RES SMD 1K OHM 1% 1/10W 
0603 

Panasonic Electronic 
Components ERJ-3EKF1001V 

21 2 R217,R218 2.2k 
RES SMD 2.2K OHM 1% 
1/10W 0603 

Panasonic Electronic 
Components ERJ-3EKF2201V 

22 1 U1 CXP-A08-14-00 LCC 5.0X7.0x1.75mm 
MiS Technologies 
Corporation CXP-A08-14-00 

23 1 U1A CY29412FLXI Clock generator, LCC package Cypress CY29412FLXI 

24 1 U7 
CY8C5868LTI-
LP039 QFN68 CY8C5868LTI-LP039 QFN68 Cypress 

CY8C5868LTI-
LP039 

25 1 U8 MIC5301 
IC REG LDO ADJ 0.15A 
TSOT23-5 Microchip Technology MIC5301YD5-TR  

26 1 U10 
PUSBM12VX4-
TL,115 

TVS DIODE 5.5VWM 12VC 
6HXSON NXP Semiconductors 

PUSBM12VX4-
TL,115 

No load components 

27 3 C62,C63,C70 1UF 
CAP CER 1UF 25V 10% X5R 
0603 Taiyo Yuden TMK107BJ105KA-T 

28 1 C5 10UF 
CAP TANT 10UF 16V 10% 
1206 AVX Corporation TAJA106K016R 

29 2 C31,C35 33uF 
CAP TANT 33UF 6.3V 20% 
1206 Rohm Semiconductor TCA0J336M8R 
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Item Qty Reference Value Descriptions Manufacturer Manufacturing 
Part Number 

30 1 C33 4.7uF 
CAP CER 4.7UF 6.3V X5R 
0603 Murata Electronics  

GRM188R60J475K
E19D 

31 1 C26 2200pF 
CAP CER 2200PF 50V NP0 
0603 Murata Electronics  

GRM1885C1H222J
A01D 

32 1 C27 0.1uF 
CAP CER 0.1UF 50V Y5V 
0603 Yageo 

CC0603ZRY5V9BB
104 

33 1 J17 2 Pin Header TE_640456-2 (2-pin Header) 
TE Connectivity AMP 
Connectors 640456-2 

34 1 J4 I2C HEADER 
CONN HEADER 5POS .100 
VERT TIN Molex, LLC 22-23-2051 

35 1 J2 VIN 
CONN HEADR BRKWAY .100 
02POS STR 

TE Connectivity AMP 
Connectors 9-146280-0-02 

36 2 J13, J16 JUMPER 
CONN HEADR BRKWAY .100 
03POS STR 

TE Connectivity AMP 
Connectors 9-146280-0-03 

37 2 L7, L8 
FERRITE CHIP 
600 OHM 1.5A 

FERRITE CHIP 600 OHM 
1500MA 1206 Murata Electronics BLM31PG601SN1L 

38 6 R14,R15,R210,R225, R229, R223 0 ohm 
RES SMD 0.0 OHM JUMPER 
1/10W 

Panasonic Electronic 
Components ERJ-3GEY0R00V 

39 1 R19 15K 
RES SMD 15K OHM 0.1% 
1/10W 0603 

Panasonic Electronic 
Components ERA-3ARB153V 

40 1 R207 10k 
RES SMD 10K OHM 1% 
1/10W 0603 Yageo RC0603FR-0710KL 

41 1 R208 6.04K 
RES SMD 6.04K OHM 1% 
1/10W 0603 Yageo 

RC0603FR-
076K04L 

42 1 R4 0 
RES SMD 0.0 OHM JUMPER 
1/10W (0402pkg) 

Panasonic Electronic 
Components ERJ-2GE0R00X 

43 1 R5 127 
RES SMD 127 OHM 1% 
1/10W 0603 

Panasonic Electronic 
Components ERJ-3EKF1270V 

44 1 R206 1K 
RES SMD 1K OHM 1% 1/10W 
0603 

Panasonic Electronic 
Components ERJ-3EKF1001V 

45 1 R203 8.25K 
RES SMD 8.25K OHM 1% 
1/10W 0603 Yageo 

RC0603FR-
078K25L 

46 1 R204 18k 
RES SMD 18K OHM 1% 
1/10W 0603 Yageo RC0603FR-0718KL 

47 9 
TP13,TP14,TP15,TP31,TP34,TP35,TP
36,TP37,TP38 BLACK 

TEST POINT 43 HOLE 65 
PLATED BLACK Keystone Electronics 5001 

48 1 U9 MIC5301 
IC REG LDO ADJ 0.15A 
TSOT23-5 Microchip Technology MIC5301YD5-TR  

Accessories          

49 1 ACC1 121-60414-01 
ASSY, PCBA, CY3641 
Programming Kit Cypress Approved CM -NA- 

50 1 ACC2 600-60421-01 

PCB, 82 mm x 64 mm, Normal 
Tg, ENIG finish, 2 layer, Color 
= RED Silk = WHITE Cypress Approved CM -NA- 

51 1 ACC3 610-60369-01 

DRW, FABRICATION 
DRAWING, CY3641 
Programming Kit Cypress Approved CM -NA- 

52 1 ACC4 620-60376-01 
DRW, ASSEMBLY DRAWING, 
CY3641 Programming Kit Cypress Approved CM -NA- 

53 1 ACC5 630-60390-01 

DRW, SCHEMATIC 
DRAWING, CY3641 
Programming Kit Cypress Approved CM -NA- 

54 1 ACC6 899-60120-01 

LBL, PCA Label, Vendor Code, 
Datecode, Serial Number xxx-
xxxxx-xx Rev xx 
(YYWWVVXXXXX) Cypress Approved CM -NA- 

55 1 ACC7 899-60219-01 
LBL, CY3641 Programming Kit 
QR Code, 10mm X 10mm Cypress Approved CM -NA- 

56 1 ACC8 
702-60011-01 
rev 01 

STDOFF, HEX, STANDOFF, 
4-40, NYLON, 1/2" Keystone -NA- 
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Item Qty Reference Value Descriptions Manufacturer Manufacturing 
Part Number 

57 1 ACC9 
700-60103-01 
rev 01 

HW, MACHINE SCREW 
BINDING SLOTTED 4-40 Keystone -NA- 

58 2 J1, J5 

Install jumper 
across pins 1 
and 2  

HW, CONN, Rectangular, MINI 
JUMPER, 6.5mm, CLOSE 
TYPE, BLACK, NICKEL 

Sullins Connector 
Solutions STC02SYAN 

 

D.2 CY3642 Schematics, Bill of Materials, and Fab Drawing 
D.2.1  Schematic  

Figure D-6. Block Diagram 
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Figure D-7. Power Supply Design and LED Indicators 

 
 

Figure D-8. Controller Schematics 
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Figure D-9. Schematics for Socket Connection 

 

D.2.2  Fab Drawing 
Figure D-10. Fabrication Drawing 
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D.2.3  Bi l l  o f  Materia ls  

Item Qty Reference Value Description Manufacturer Manufacturing 
Part Number 

1 1 C6 0.01 UF 
CAP CER 10000PF 50V 10% 
X7R 0603 Murata Electronics  

GRM188R71H103K
A01D 

2 1 C7 4.7uF 
CAP CER 4.7UF 6.3V X5R 
0603 Murata Electronics 

GRM188R60J475K
E19D 

3 13 
C8,C38,C41,C46,C49,C53,C54,C55,C5
6,C57,C66,C67,C68 0.1uF CAP CER 0.1UF 50V Y5V 0603 Yageo 

CC0603ZRY5V9BB
104 

4 9 
C30,C34,C39,C40,C50,C51,C52,C58,C
59 1UF 

CAP CER 1UF 25V 10% X5R 
0603 Taiyo Yuden TMK107BJ105KA-T 

5 1 F1 

PTC 
RESETABLE 
FUSE 

PTC RESETTABLE .30A 30V 
1812 Bourns Inc. MF-MSMF030-2 

6 1 J1 JUMPER 
CONN HEADR BRKWAY .100 
03POS STR 

TE Connectivity AMP 
Connectors 9-146280-0-03 

7 1 J3 USB MINI B MINI USB RCPT R/A DIP 
TE Connectivity AMP 
Connectors 1734510-1 

8 1 LED1 LED Green LED GREEN CLEAR 0805 SMD 
Visual Communications 
Company - VCC 

CMD17-
21VGC/TR8 

9 1 LED2 LED Amber LED AMBER CLEAR 0805 SMD Bivar Inc. SM0805AC 

10 2 R1,R211 560 
RES SMD 560 OHM 5% 1/10W 
0603 

Panasonic Electronic 
Components ERJ-3GEYJ561V 

11 1 R3 100K 
RES SMD 100K OHM 5% 
1/10W 0603 

Panasonic Electronic 
Components ERJ-3GEYJ104V 

12 3 R16,R226,R228 15K 
RES SMD 15K OHM 1% 1/10W 
0603 

Panasonic Electronic 
Components ERJ-3EKF1502V 

13 2 R17,R18 22 
RES SMD 22 OHM 1% 1/10W 
0603 

Panasonic Electronic 
Components ERJ-3EKF22R0V 

14 3 R20,R21,R227 30K 
RES SMD 30K OHM 1% 1/10W 
0603 Yageo RC0603FR-0730KL 

15 1 R201, R202 10k 
RES SMD 10K OHM 1% 1/10W 
0603 Yageo RC0603FR-0710KL 

16 5 R213,R214,R224,R230, R232 0 ohm 
RES SMD 0.0 OHM JUMPER 
1/10W 

Panasonic Electronic 
Components ERJ-3GEY0R00V 

17 1 R216 1K 
RES SMD 1K OHM 1% 1/10W 
0603 

Panasonic Electronic 
Components ERJ-3EKF1001V 

18 2 R217,R218 2.2k 
RES SMD 2.2K OHM 1% 1/10W 
0603 

Panasonic Electronic 
Components ERJ-3EKF2201V 

19 1 U1 CXP-C08-13-00 LCC 3.2X5.0X1.45mm 
MiS Technologies 
Corporation CXP-C08-13-00 

20 1 U1A CY29422FLXI Clock generator, LCC package Cypress CY29422FLXI 

21 1 U7 
CY8C5868LTI-
LP039 QFN68 CY8C5868LTI-LP039 QFN68 Cypress 

CY8C5868LTI-
LP039 

22 1 U8 MIC5301 
IC REG LDO ADJ 0.15A 
TSOT23-5 Microchip Technology MIC5301YD5-TR  

23 1 U10 
PUSBM12VX4-
TL,115 

TVS DIODE 5.5VWM 12VC 
6HXSON NXP Semiconductors 

PUSBM12VX4-
TL,115 

No load components 

24 3 C62,C63,C70 1UF 
CAP CER 1UF 25V 10% X5R 
0603 Taiyo Yuden TMK107BJ105KA-T 

25 1 C5 10UF 
CAP TANT 10UF 16V 10% 
1206 AVX Corporation TAJA106K016R 

26 2 C31,C35 33uF 
CAP TANT 33UF 6.3V 20% 
1206 Rohm Semiconductor TCA0J336M8R 

27 2 C10, C33 4.7uF 
CAP CER 4.7UF 6.3V X5R 
0603 Murata Electronics  

GRM188R60J475K
E19D 

28 1 C26 2200pF 
CAP CER 2200PF 50V NP0 
0603 Murata Electronics  

GRM1885C1H222J
A01D 

29 2 C9, C27 0.1uF CAP CER 0.1UF 50V Y5V 0603 Yageo 
CC0603ZRY5V9BB
104 
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Item Qty Reference Value Description Manufacturer Manufacturing 
Part Number 

30 1 J17 2 Pin Header TE_640456-2 (2-pin Header) 
TE Connectivity AMP 
Connectors 640456-2 

31 1 J2 VIN 
CONN HEADR BRKWAY .100 
02POS STR 

TE Connectivity AMP 
Connectors 9-146280-0-02 

32 1 J16 JUMPER 
CONN HEADR BRKWAY .100 
03POS STR 

TE Connectivity AMP 
Connectors 9-146280-0-03 

33 1 J4 I2C HEADER 
CONN HEADER 5POS .100 
VERT TIN Molex, LLC 22-23-2051 

34 1 J5 VCM 
CONN HEADR BRKWAY .100 
02POS STR 

TE Connectivity AMP 
Connectors 9-146280-0-02 

35 2 J6,J7 SMA 
CONN SMA JACK 50 OHM 
EDGE MNT 

Cinch Connectivity 
Solutions Johnson 142-0701-801 

36 1 J13 JUMPER 
CONN HEADR BRKWAY .100 
03POS STR 

TE Connectivity AMP 
Connectors 9-146280-0-03 

37 2 L7, L8 
FERRITE CHIP 
600 OHM 1.5A 

FERRITE CHIP 600 OHM 
1500MA 1206 Murata Electronics BLM31PG601SN1L 

38 1 R4 0 
RES SMD 0.0 OHM JUMPER 
1/10W (0402pkg) 

Panasonic Electronic 
Components ERJ-2GE0R00X 

39 1 R5 127 
RES SMD 127 OHM 1% 1/10W 
0603 

Panasonic Electronic 
Components ERJ-3EKF1270V 

40 6 R14,R15,R210,R225, R229, R223 0 ohm 
RES SMD 0.0 OHM JUMPER 
1/10W 

Panasonic Electronic 
Components ERJ-3GEY0R00V 

41 1 R19 15K 
RES SMD 15K OHM 0.1% 
1/10W 0603 

Panasonic Electronic 
Components ERA-3ARB153V 

42 1 R207 10k 
RES SMD 10K OHM 1% 1/10W 
0603 Yageo RC0603FR-0710KL 

43 1 R208 6.04K 
RES SMD 6.04K OHM 1% 
1/10W 0603 Yageo 

RC0603FR-
076K04L 

44 1 R206 1K 
RES SMD 1K OHM 1% 1/10W 
0603 

Panasonic Electronic 
Components ERJ-3EKF1001V 

45 2 R30,R31 49.9 
RES SMD 49.9 OHM 0.1% 
1/10W 0603 

Panasonic Electronic 
Components ERA-3AEB49R9V 

46 1 R203 8.25K 
RES SMD 8.25K OHM 1% 
1/10W 0603 Yageo 

RC0603FR-
078K25L 

47 1 R204 18k 
RES SMD 18K OHM 1% 1/10W 
0603 Yageo RC0603FR-0718KL 

48 9 
TP13,TP14,TP15,TP31,TP34,TP35,TP3
6,TP37,TP38 BLACK 

TEST POINT 43 HOLE 65 
PLATED BLACK Keystone Electronics 5001 

49 1 U9 MIC5301 
IC REG LDO ADJ 0.15A 
TSOT23-5 Microchip Technology MIC5301YD5-TR  

Accessories          

50 1 ACC1 121-60415-01 
ASSY, PCBA, CY3642 
Programming Kit Cypress Approved CM -NA- 

51 1 ACC2 600-60422-01 

PCB, 82 mm x 64 mm, Normal 
Tg, ENIG finish, 2 layer, Color = 
RED, Silk = WHITE Cypress Approved CM -NA- 

52 1 ACC3 610-60370-01 

DRW, FABRICATION 
DRAWING, CY3642 
Programming Kit Cypress Approved CM -NA- 

53 1 ACC4 620-60377-01 
DRW, ASSEMBLY DRAWING, 
CY3642 Programming Kit Cypress Approved CM -NA- 

54 1 ACC5 630-60391-01 
DRW, SCHEMATIC DRAWING, 
CY3642 Programming Kit Cypress Approved CM -NA- 

55 1 ACC7 899-60120-01 

LBL, PCA Label, Vendor Code, 
Datecode, Serial Number xxx-
xxxxx-xx Rev xx 
(YYWWVVXXXXX) Cypress Approved CM -NA- 

56 1 ACC6 899-60219-01 
LBL, CY3642 Programming Kit 
QR Code, 10mm X 10mm Cypress Approved CM -NA- 

57 1 ACC8 
702-60011-01 
rev 01 

STDOFF, HEX, STANDOFF, 4-
40, NYLON, 1/2" Keystone -NA- 
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Item Qty Reference Value Description Manufacturer Manufacturing 
Part Number 

58 1 ACC9 
700-60103-01 
rev 01 

HW, MACHINE SCREW 
BINDING SLOTTED 4-40 Keystone -NA- 

59 1 J1 
700-60080-01 
rev 01 

HW, CONN, Rectangular, MINI 
JUMPER, 6.5mm, CLOSE 
TYPE, BLACK, NICKEL Sullins Connector Solutions STC02SYAN 
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D.3 CY3643 Schematics, Bill of Materials, and Fab Drawing 
D.3.1  Schematic  

Figure D-11. Block Diagram 

 
Figure D-12. Power Supply Design and LED Indicators 
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Figure D-13. Controller Schematics 

 
 

Figure D-14. Schematics for Socket Connection 
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D.3.2  Fab Drawing 
Figure D-15. Fabrication Drawing 

 
 

D.3.3  Bi l l  o f  Materia ls  

Item Qty Reference Value Description Manufacturer Manufacturing Part 
Number 

1 1 C6 0.01 UF 
CAP CER 10000PF 50V 10% 
X7R 0603 Murata Electronics  

GRM188R71H103KA0
1D 

2 15 
C7,C11,C38,C41,C46,C49,C53,C5
4,C55,C56,C57,C65,C66,C67,C68 0.1uF CAP CER 0.1UF 50V Y5V 0603 Yageo 

CC0603ZRY5V9BB10
4 

3 11 
C8,C30,C34,C39,C40,C50,C51,C5
2,C58,C59,C69 1UF 

CAP CER 1UF 25V 10% X5R 
0603 Taiyo Yuden TMK107BJ105KA-T 

4 1 F1 

PTC 
RESETABLE 
FUSE 

PTC RESETTABLE .30A 30V 
1812 Bourns Inc. MF-MSMF030-2 

5 1 J3 USB MINI B MINI USB RCPT R/A DIP 
TE Connectivity AMP 
Connectors 1734510-1 

6 1 J1 JUMPER 
CONN HEADR BRKWAY .100 
03POS STR 

TE Connectivity AMP 
Connectors 9-146280-0-03 

7 1 LED1  LED Green LED GREEN CLEAR 0805 SMD 
Visual Communications 
Company - VCC CMD17-21VGC/TR8 

8 1 LED2 LED Amber LED AMBER CLEAR 0805 SMD Bivar Inc. SM0805AC 
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Item Qty Reference Value Description Manufacturer Manufacturing Part 
Number 

9 2 R1,R211 560 
RES SMD 560 OHM 5% 1/10W 
0603 

Panasonic Electronic 
Components ERJ-3GEYJ561V 

10 1 R3 100K 
RES SMD 100K OHM 5% 1/10W 
0603 

Panasonic Electronic 
Components ERJ-3GEYJ104V 

11 3 R16,R226,R228 15K 
RES SMD 15K OHM 1% 1/10W 
0603 

Panasonic Electronic 
Components ERJ-3EKF1502V 

12 2 R17,R18 22 
RES SMD 22 OHM 1% 1/10W 
0603 

Panasonic Electronic 
Components ERJ-3EKF22R0V 

13 3 R20,R21,R227 30K 
RES SMD 30K OHM 1% 1/10W 
0603 Yageo RC0603FR-0730KL 

14 1 R201, R202 10k 
RES SMD 10K OHM 1% 1/10W 
0603 Yageo RC0603FR-0710KL 

15 6 
R213, R214, R224, R230, R231, 
R233 0 ohm 

RES SMD 0.0 OHM JUMPER 
1/10W 

Panasonic Electronic 
Components ERJ-3GEY0R00V 

16 1 R216 1K 
RES SMD 1K OHM 1% 1/10W 
0603 

Panasonic Electronic 
Components ERJ-3EKF1001V 

17 2 R217,R218 2.2k 
RES SMD 2.2K OHM 1% 1/10W 
0603 

Panasonic Electronic 
Components ERJ-3EKF2201V 

18 1 U1 
16QN50AH230
30 

QFN socket 
16 contacts, 0.5 mm pitch, 
3.0x3.0 mm body, Thin Device 

PLASTRONICS SOCKET 
COMPANY 16QN50AH23030 

19 1 U1A CY29430FLQXI Clock generator, QFN package Cypress CY29430FLQXI 

20 1 U7 
CY8C5868LTI-
LP039 QFN68 CY8C5868LTI-LP039 QFN68 Cypress CY8C5868LTI-LP039 

21 1 U8 MIC5301 
IC REG LDO ADJ 0.15A 
TSOT23-5 Microchip Technology MIC5301YD5-TR  

22 1 U10 
PUSBM12VX4-
TL,115 

TVS DIODE 5.5VWM 12VC 
6HXSON NXP Semiconductors PUSBM12VX4-TL,115 

No load components 

23 1 C5 10UF CAP TANT 10UF 16V 10% 1206 AVX Corporation TAJA106K016R 

24 2 C31,C35 33uF CAP TANT 33UF 6.3V 20% 1206 Rohm Semiconductor TCA0J336M8R 

25 3 C62,C63,C70 1UF 
CAP CER 1UF 25V 10% X5R 
0603 Taiyo Yuden TMK107BJ105KA-T 

26 2 C10, C33 4.7uF CAP CER 4.7UF 6.3V X5R 0603 Murata Electronics  
GRM188R60J475KE1
9D 

27 1 C13 10pF CAP CER 10PF 50V C0G 0603 TDK Corporation 
C1608C0G1H100C08
0AA 

28 1 C26 2200pF CAP CER 2200PF 50V NP0 0603 Murata Electronics  
GRM1885C1H222JA0
1D 

29 2 C9, C27 0.1uF CAP CER 0.1UF 50V Y5V 0603 Yageo 

CC0603ZRY5V9BB10
4 

30 2 C12, C28 20nF CAP CER 0.02UF 50V X7R 0603 
Samsung Electro-Mechanics 
America, Inc. CL10B203KB8NNNC 

31 1 J4 I2C HEADER 
CONN HEADER 5POS .100 
VERT TIN Molex, LLC 22-23-2051 

32 1 J17 2 Pin Header TE_640456-2 (2-pin Header) 
TE Connectivity AMP 
Connectors 640456-2 

33 2 J2, J5 VIN 
CONN HEADR BRKWAY .100 
02POS STR 

TE Connectivity AMP 
Connectors 9-146280-0-02 

34 4 J13, J14,J15,J16 JUMPER 
CONN HEADR BRKWAY .100 
03POS STR 

TE Connectivity AMP 
Connectors 9-146280-0-03 

35 4 J7,J8,J10,J11 SMA 
CONN SMA JACK 50 OHM 
EDGE MNT 

Cinch Connectivity Solutions 
Johnson 142-0701-801 

36 2 L7, L8 
FERRITE CHIP 
600 OHM 1.5A 

FERRITE CHIP 600 OHM 
1500MA 1206 Murata Electronics BLM31PG601SN1L 

37 9 
R4,R14,R15,R40,R41,R42,R210,R
223, R229  0 ohm 

`RES SMD 0.0 OHM JUMPER 
1/10W 

Panasonic Electronic 
Components ERJ-3GEY0R00V 

38 1 R5 453 
RES SMD 453 OHM 1% 1/10W 
0603 

Panasonic Electronic 
Components ERJ-3EKF4530V 

http://digikey.com/Suppliers/us/Yageo.page?lang=en
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Item Qty Reference Value Description Manufacturer Manufacturing Part 
Number 

39 1 R6 127 
RES SMD 127 OHM 1% 1/10W 
0603 

Panasonic Electronic 
Components ERJ-3EKF1270V 

40 1 R7 0 ohm 
RES SMD 0.0 OHM JUMPER 
1/10W (0402pkg) 

Panasonic Electronic 
Components ERJ-2GE0R00X 

41 1 R19 15K 
RES SMD 15K OHM 5% 1/10W 
0603 

Panasonic Electronic 
Components ERJ-3GEYJ153V 

42 2 R30,R31 49.9 
RES SMD 49.9 OHM 0.1% 1/10W 
0603 

Panasonic Electronic 
Components ERA-3AEB49R9V 

43 1 R203 8.25K 
RES SMD 8.25K OHM 1% 1/10W 
0603 Yageo RC0603FR-078K25L 

44 1 R204 18k 
RES SMD 18K OHM 1% 1/10W 
0603 Yageo RC0603FR-0718KL 

45 3 R206,R216,R225 1k 
RES SMD 1K OHM 1% 1/10W 
0603 

Panasonic Electronic 
Components ERJ-3EKF1001V 

46 1 R207 10k 
RES SMD 10K OHM 1% 1/10W 
0603 Yageo RC0603FR-0710KL 

47 1 R208 6.04K 
RES SMD 6.04K OHM 1% 1/10W 
0603 Yageo RC0603FR-076K04L 

48 2 R221,R222 2.2K 
RES SMD 2.2K OHM 5% 1/10W 
0603 Yageo RC0603JR-072K2L 

49 7 
TP13,TP14,TP15,TP31,TP34,TP3
5,TP36 BLACK 

TEST POINT 43 HOLE 65 
PLATED BLACK Keystone Electronics 5001 

50 1 U9 MIC5301 
IC REG LDO ADJ 0.15A 
TSOT23-5 Microchip Technology MIC5301YD5-TR  

51 1 Y1 CRYSTAL4/SM 
CRYSTAL 114.2850MHZ 18PF 
SMD NDK 

NX3225SA-
114.285MHZ-EXS00A-
CS06528 

Accessories 

52 1 ACC1 121-60416-01 
ASSY, PCBA, CY3642 
Programming Kit Cypress Approved CM -NA- 

53 1 ACC2 600-60423-01 

PCB, 82 mm x 64 mm, Normal 
Tg, ENIG finish, 2 layer, Color = 
RED, Silk = WHITE Cypress Approved CM -NA- 

54 1 ACC3 610-60371-01 
DRW, FABRICATION DRAWING, 
CY3642 Programming Kit Cypress Approved CM -NA- 

55 1 ACC4 620-60378-01 
DRW, ASSEMBLY DRAWING, 
CY3642 Programming Kit Cypress Approved CM -NA- 

56 1 ACC5 630-60392-01 
DRW, SCHEMATIC DRAWING, 
CY3642 Programming Kit Cypress Approved CM -NA- 

57 1 ACC6 899-60120-01 

LBL, PCA Label, Vendor Code, 
Datecode, Serial Number xxx-
xxxxx-xx Rev 03 
(YYWWVVXXXXX) Cypress Approved CM -NA- 

58 1 ACC7 899-60220-01 
LBL, CY3643 Programming Kit 
QR Code, 10mm X 10mm Cypress Approved CM -NA- 

59 1 ACC8 
702-60011-01 
rev 01 

STDOFF, HEX, STANDOFF, 4-
40, NYLON, 1/2" Cypress Approved CM -NA- 

60 1 ACC9 
700-60103-01 
rev 01 

HW, MACHINE SCREW 
BINDING SLOTTED 4-40 Cypress Approved CM -NA- 

61 1 J1 
700-60080-01 
rev 01 

HW, CONN, Rectangular, MINI 
JUMPER, 6.5mm, CLOSE TYPE, 
BLACK, NICKEL Sullins Connector Solutions STC02SYAN 
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Revision History 

 

 

Document Title: CY3641, CY3642, and CY3643 Programming Kits Guide 

Document Number: 002-19586 

Revision Issue Date 
Origin of 
Change 

Description of Change 

** 07/13/2017 PAWK Initial version of the kit guide. 

*A 09/08/2017 PAWK Updated Document Title to read as "CY3641, CY3642, and CY3643 Programming Kits Guide". 

*B 09/13/2017 PAWK 

Added Cypress clock IC CY294xx to Section 1.1 
Added example configuration files that would programme the clock ICs for VDD of 2.5V to 
Section 2 
Updated Section 3 to indicate that PSoC programmer 3.27 and Clock Programmer 1.17 support 
CY364x kits  
Updated Section 4, Figure 4-1, 4-2 and 4-3 to conform to latest hardware   
Added Appendix B, Possible Hardware Modification   
Updated Appendix C, Schematics  

 


	1.   Introduction
	1.1   CY364x Programming Kits Contents
	1.2   Getting Started
	1.3   Additional Learning Resources
	1.4   Technical Support
	1.5   Document Conventions
	1.6   Acronyms

	2.   Software Installation
	2.1   Before You Begin
	2.2   Install Software
	2.3   Install Hardware
	2.4   Uninstall Software

	3.   Kit Operation
	3.1   Theory of Operation
	3.2   Functional Description
	3.3   CY364x Kit USB Connection
	3.4   eFuse Programming of the CY294xx Clock Device 

	4.   Hardware
	4.1   Board Overview

	5.   Additional Features of CY3641
	5.1   Power up the Clock Device
	5.2   Measuring Parameters of the Programmed Clock Device

	A. Using Bridge Control Panel with an I2C Configuration File
	B. Possible Hardware Modification
	C. Generating a Device Configuration
	D. Schematics, Bill of Materials, and Fab Drawing

